
Release Notes for Nuke
9.0v5b17

Release Date
20 February 2015

Qualified Operating Systems
• Mac OS X 10.7 (Lion), 10.8 (Mountain Lion), 10.9 (Mavericks)

NOTE: Nuke is expected to function correctly underMac OS X 10.9 (Mavericks), but we are seeing UI
performance degradation compared to previous OS X versions. We areworking on resolving these issues.

• Windows 7 64-bit andWindows 8 64-bit

• CentOS/RHEL 5 and CentOS/RHEL 6

Other operating systemsmay work with Nuke, but have not been fully tested. If you have any problemswith a
particular operating system, please contact support@thefoundry.co.uk.

Hardware Requirements for Real-time Playback

The following is a list of recommended hardware configurations that The Foundry have certified for 4K real-time
playback (see the note below). Please note that 4K playback may also work on othermachine configurations, but the
ones listed below are ones which have been tested.

NOTE: The 4K playback requirements listed here refer to streaming playback for 10-bit DPX rgb files at 30
fps, 4K UHD, with audio and amonitor output device enabled. Other file formatsmay also play back at 4K
and above, given sufficient disk read speeds.

mailto:support@thefoundry.co.uk
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Mac Certified Box Hardware
• Mac Pro, Late 2013

• SoftwareOS X 10.9.5 (13F34)

• 3.5 GHz 6-Core Intel Xeon E5

• GPU - FirePro D500 3072 MB

• 32 GB 1867 MHz DDR3 ECC

Monitor Output
• BlackMagic: UltraStudio 4K (Thunderbolt 2)

• Desktop Video Software Driver 10.3

• Thunderbolt 2

• Download Link: https://www.blackmagicdesign.com/support/download/35045/Mac%20OS%20X

OR

• AJA: IO4K (Thunderbolt 2)

• Mac Driver v10.6 (Firmware version 'IO4K (4Kmode)'

• Download Link: http://www.aja.com/assets/support/files/2697/en/AJA_Io4K_10_6.zip

WARNING: T-Tap is not currently supported.

Windows Certified Box Hardware
• Windows 7

• 2 x 3.4 GHz, 8-Core

• NVIDIAQuadro K5200, NVIDIA Driver 340.x

• 32 GB RAM

Monitor Output
• BlackMagic: Decklink 4K ExtremeORDecklink 4K Studio

• Desktop Video Driver 10.3

• Download Link: https://www.blackmagicdesign.com/support/download/35045/Windows

OR

• AJA: Kona 3G OR Kona 4

• AJA Hardware Driver v10.5.2 - Windows (64-bit)

• Download Link: http://www.aja.com/assets/support/files/2620/en/AJA_Win_Drivers-10.5.2-x64.msi.zip

RELEASE NOTES FOR NUKE 9.0V5B17 |

https://www.blackmagicdesign.com/support/download/35045/Mac OS X
http://www.aja.com/assets/support/files/2697/en/AJA_Io4K_10_6.zip
https://www.blackmagicdesign.com/support/download/35045/Windows
http://www.aja.com/assets/support/files/2620/en/AJA_Win_Drivers-10.5.2-x64.msi.zip


3

Linux Certified Box Hardware
• CentOS/RHEL 6.5

• 2 x 3.4 GHz, 8-Core

• NVIDIAQuadro K5200, NVIDIA Driver 340.x

• 32 GB RAM

Monitor Output
• BlackMagic Decklink 4K Extreme, Decklink 4K Studio

• Desktop Video Driver 10.3

• Download Link: https://www.blackmagicdesign.com/support/download/35045/Linux

Disk Storage and Read/Speeds
• Windows/Linux: HP Z Turbo DriveOR Fusion ioFX, PCIe cards

• Mac OS X: LaCie Little Big Disk 1TB, Thunderbolt 2

• Network attached storage: Minimumof sustained 1GB/s read speed

NOTE: See theNukeUser Guide Installation and Licensing section or the online help here, regarding
example formats and data rates.

Requirements for GPU Acceleration

If you want to enable Nuke to calculate certain nodes using theGPU, there are some additional requirements. You
need to have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is
available at www.nvidia.co.uk/object/cuda_gpus_uk.html

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software
update.

With graphics drivers capable of running CUDA 4.2 or above.

NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or higher) is
required.

• OnWindows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU.
Drivers fromApril 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us formore information.
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• OnMac, the CUDA driver is separate from theNVIDIA graphics driver andmust be installed, if you don't have it
already. Theminimum requirement for CUDA 4.2 is driver version 4.2.5, which can be downloaded from
www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.

• an AMD FirePro GPU on late 2013 Mac Pro 6.1, running OS X 10.9.3 'Mavericks', or later (see below and the Blink
API documentation for caveats on CPU/GPU result consistency onMac Pros).

Late 2013 Mac Pro Only

Nuke 9.0 supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 (running OS X 10.9.3 'Mavericks', or later),
including a new Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared
between the available GPUs for extra processing speed.

NOTE: To ensure you get the best performance fromOpenCL GPUs on late 2013 Mac Pro 6,1, we
recommend updatingMavericks to 10.9.5, or above for full functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater than 4 mega
pixels resolution, VectorGenerator, Kronos, andMotionBlur do not support GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos andMotionBlur do not support GPU
acceleration.

Launching and Licensing Information
• Nuke can be run on the command line from the installation directory without any arguments. For example, on
Windows:
C:\Program Files\Nuke9.0v5\Nuke9.0.exe

NukeX and Nuke Studio can be run on the command line from the installation directory using the --nukex and        
--studio arguments. For example, onWindows:
C:\Program Files\Nuke9.0v5\Nuke9.0.exe --studio

• NukeX requires nukex_i and nuke_i licenses with valid maintenance.

• Nuke Studio requires nukestudio_i, nukex_i, and nuke_i licenses with valid maintenance.

New Features
• BUG ID 27501 - Support for Blackmagic RAW 2.5K CinemaDNG has been added.
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Feature Enhancements
• BUG ID 30272 - Transcode Exporter: A new to scale option has been added to theReformat dropdown.

• BUG ID 44508 - Timeline: Undo, Redo, Clone, Copy as Clones, andDeclone have been added to the timeline
right-click Editmenu.

• BUG ID 45848 - Viewer/Timeline: Zooming functionality in the Viewer frame slider and timeline has been
refactored.

• BUG ID 46605 - Export: Build Track from Export Structure or Tag can now use an existing track if the same
name is used and warns if a track item is about to be overwritten.

• BUG ID 47074 - Soft Effects: Node presets, chosen using thewrench icon in node properties, have been enabled
for Soft Effects.

• BUG ID 47351 - Support has been added for drop frame timecodes in .mov files.

• BUG ID 47560 - Nuke Assist: TheGrade node has been added to Nuke Assist.

• BUG ID 47598 - Nuke Studio now uses libpng 1.4.8 and plug-ins should be built against this version.

Bug Fixes

Create Comp
• BUG ID 46869 - Comping files containing unsupported characters in their file names caused Nuke to become
unresponsive or crash.

• BUG ID 47441 - Selecting Effects > Create Compwith Preferences > General > force project autosave after
set to 1-3 seconds, caused Nuke Studio to becomeunresponsive.

• BUG ID 47594 - Nuke Studio incorrectly treated certain .mov files as having drop frame timecodes.

Curve Editor/Dope Sheet
• BUG ID 44765 - Curve Editor: Changing curve interpolation was not always registered as a separate undo action.

Exports
• BUG ID 46403 - Controls set in the Export dialog Content tab always defaulted to the values from theNuke
Write Node Content preset.

• BUG ID 47283 - Selecting Build Track > From Export Tag with theMedia tab open caused Nuke Studio to crash.

• BUG ID 47305 - Selecting Build Track > From Export Tag in a certain project, with Apply Retimes enabled in the
Basic Nuke Shot preset, caused Nuke Studio to crash.

• BUG ID 47306 - Transcoding with Apply Retimes enabled in a certain script did not work as expected.

RELEASE NOTES FOR NUKE 9.0V5B17 | FEATURE ENHANCEMENTS
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• BUG ID 47354 - Build Track > From Export Tag did not work as expected withmultiple transcodes in the same
export.

• BUG ID 47551 - Using thewholeClip Length in an export and then selecting Build Track > From Export Tag
added handles to the clip in thewrong place.

Linux Only
• BUG ID 46873 - Opening the help dialog of any GenArts Sapphire plug-in caused Nuke to crash.

Mac OS X Only
• BUG ID 44637 - Mac OS X 10.10 (Yosemite) only: Dragging and droppingmedia into theNodeGraph did not work
as expected.

• BUG ID 47507 - Cmd+dragging values between control panels to create expression links didn't work as expected if
the Preference > Control Panels > new panels go towas set to own window in a legacy Nuke 8
preferences8.0.nk file.

OCIO
• BUG ID 40033 - Adding an OCIOCDLTransform that referenced certain .ccc files and clicking select occid caused
Nuke to crash.

• BUG ID 45992 - Setting the Viewer process to the default OCIO LUTs did not display some channels correctly.

• BUG ID 47082 - Certain OCIO config files caused Nuke to crash.

Preferences
• BUG ID 47514 - Setting the Preferences > Project Defaults > General > time display control to frames didn't
work as expected.

Read and Write
• BUG ID 35067 -WriteGeo: A certain customer script containing aWriteGeo node caused Nuke to crash.

• BUG ID 38192/46282 - Alembic: Loading Cameras and Axis nodes from .abc files always loaded animation at 24
fps, regardless of the frame rate set in the file.

• BUG ID 45739 - Nuke did not render drop frame timecodes to .mov files correctly.

• BUG ID 47003 - Playback for ProRes files was not as consistent as previous releases.

• BUG ID 47045 -mov64Reader: Trimming or cutting an .mp4 track item occasionally displayed only black frames
and a requested layer not found error.

• BUG ID 47361 - Connecting an un-cachedWrite node set to rendermulti-channel .exr output caused Nuke to
crash.

• BUG ID 47568 - Importing a certain Flix-generated .aaf file caused Nuke Studio to crash.

• BUG ID 47621/47622 -mov64Writer: Writing additional channels along with RGBA to aQuickTime caused Nuke to
crash.

RELEASE NOTES FOR NUKE 9.0V5B17 | BUG FIXES
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Roto/RotoPaint
• BUG ID 47145 - RotoPaint: The active RotoPaint node lost focus if another RotoPaint node had ripple edit enabled.

• BUG ID 47439 - Roto: Undo didn't work when the Compositing Viewer was in fullscreenmode on a 2ndmonitor.

Soft Effects
• BUG ID 46402 - CDL: Creating a comp containing a CDL effect did not set theworking space control correctly if a
customOCIO config was used.

• BUG ID 46875 - Creating a soft effect with a transition selected created an invalid effect.

• BUG ID 47006 - Text: Entering text containing expressions caused Nuke Studio to crash on playback.

• BUG ID 47532 - Text: The Text effect's initial bounding box wasn't drawn until pen up.

Text
• BUG ID 47422 - Text: Marquee selecting characters with tails, such as j and g, was awkward.

• BUG ID 47681 - Text: Multiple instances of the Text node in a customer script caused performance issues.

Timeline
• BUG ID 46533 - At extreme zoom levels, track items occasionally looked like gaps in the timeline.

• BUG ID 46557 - Reconnectingmultiple clips or comps from theVersions Bin caused Nuke to crash.

• BUG ID 46919 - Viewing or dragging large 5K .psd files to the timeline occasionally caused Nuke Studio to crash.

• BUG ID 46934 - SelectingOpen In > Timeline View on a comp container always opened the first version of the
comp, regardless of which version was active.

• BUG ID 47415 - Scrubbing performancewas unreliable when Tracker keyframeswere displayed in theDope Sheet.

• BUG ID 47542 - Navigating around the timelinewas sluggish in large projects.

Tracking
• BUG ID 46945 - CameraTracker: Undoing and then redoing clickingUser Tracks > Export Tracker caused Nuke
to crash.

Viewers
• BUG ID 46783 - Compositing Viewer: Enabling Stereo Mode > Interlaced stopped the Viewer updating correctly
when switching between A/B modes, such aswipe and over.

• BUG ID 46905 - Compositing Viewer: Modifying shapes or transformhandles fromdifferent nodes in the Viewer
caused the undo history to become unreliable.

• BUG ID 47446 - Compositing Viewer: The A/B input buffer dropdownmenus could become out of sync when
Viewers withmultiple inputs in theNodeGraph were disconnected.

• BUG ID 47462 - Zooming in and out of the frame slider using themousewheel did not work as expected when the
clip's frame rangewas less than 5 frames.

RELEASE NOTES FOR NUKE 9.0V5B17 | BUG FIXES
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• BUG ID 47474 - Setting Preferences > General > force project autosave after to a low value caused the
Viewer to re-cache after the specified interval when a TimeWarp soft effect was used.

• BUG ID 47477 - Setting Preferences > General > force project autosave after to a low value caused the
Viewer info bar to shift the image up or down after the specified interval.

• BUG ID 47510 - The selected playback ratewas not always displayed correctly after being saved in a script.

Windows Only
• BUG ID 47025 - Scrubbing in the frame slider when viewing a script with Dilate in theNodeGraph caused Nuke to
crash.

• BUG ID 47456 - Dragging single frame clips from the Timeline environment to theNodeGraph set the Read node
frame range control before and after dropdowns to black, rather than hold.

• BUG ID 47485 - Usingmultiple samples in Kronos orMotionBlur nodes caused Nuke to crash.

Miscellaneous
• BUG ID 14375 - The connecting pipes between nodes in theNodeGraph disappeared when zoomed out to a
certain level.

• BUG ID 46495 - File Browser: Pasting certain text into the file path field caused Nuke to crash.

• BUG ID 47123 - Selecting File > Insert Comp Nodes populated the Editmenuwith entries for all nodes inserted
in theNodeGraph.

• BUG ID 47447 - Nuke Studio projects were auto-saved when no changes weremade.

• BUG ID 47460 - Discarding changes to a project when closing it, and then saving changes to a compwithin the
project, caused Nuke Studio to crash.

• BUG ID 47500 - Stereo: The Compositing Viewer flickered onmousemovewhenNo incomplete stereo and A/B
wipemodewere enabled.

• BUG ID 47598 - Nuke Studio shipped with two versions of libpng, causing problemswhen building plug-ins against
the out of date version.

• BUG ID 47671 - Documentation: TheMerge nodeminus function description was incorrect in theNuke Reference
Guide.

Known Issues and Workarounds
This section covers known issues and gives workarounds for them, where appropriate.

Known Issues Specific to Nuke 9.0

Flipbook
• BUG ID 47691 - dngReader: Flipbooking .dng files doesn't always honor the selected LUT, resulting in a color shift.

RELEASE NOTES FOR NUKE 9.0V5B17 | KNOWN ISSUES ANDWORKAROUNDS
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• BUG ID 47005 - In the Flipbook Viewer, clicking theGo to start button always goes to frame 0, even if the clip
doesn't start at 0.

• BUG ID 47001 - Enabling Burn in the LUT in the Flipbook dialog uses the rec709 LUT for both rec709 and
rec1886.

GPU
• BUG ID 47742 - Viewer: Nodes that draw overlays in the Viewer, such as Denoise, can render output in theworng
colorspacewhile the overlays are displayed.

You can workaround this by disabling use GPU for Viewer when possible in the Preferences > Panels >
Viewer (Comp) tab.

• BUG ID 45018 - R3D: Only half float linear gamma spaceworks with GPU debayering.

Installation and Licensing
• Mac OS X only: If you're runningMacOS X 10.10 "Yosemite", youmay need to install alternative NVIDIA CUDA
drivers so that Nuke can detect your GPU correctly. You can obtain the required drivers directly fromNVIDIA here:

http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html

• BUG ID 41981 - Licensing: Launching Nuke on newMacPros withmultiple Thunderbolt devicesmay display a
licensing dialog explaining that FLEXlm licensing has been disabled, probably due to having toomany ethernet
addresses active on themachine.

Please contact support@thefoundry.co.uk to work around this issue.

Linux Only
• BUG ID 42581 - Keyboard Shortcuts: Using Ctrl+C to quit Nuke from the command linewhen a dialog box is open
displays an error.

Read and Write
• BUG ID 47574 -movWriter: Rendering two .mov files concurrently produces an unsupported codec error and
occasionally causes Nuke to crash.

• BUG ID 47256 - MXF: Super whites are currently displayed as white in the Timeline Viewer.

• BUG ID 47248 - MXF: Setting debayer quality toHigh Quality on some Sony RAW files displays an error
decoding framemessage in the Comp Viewer.

• BUG ID 42717 - Certain .exr files rendered fromModo display the alpha channel rather than the rgba channels by
default.

• BUG ID 31424 - Sub-sampling in .exr files is not currently supported.

Miscellaneous
• BUG ID 47670 - Clicking Cancel on the Preferences dialog occasionally causes Nuke to crash.
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• BUG ID 47265 - RotoPaint: Painting in the Comp Viewer with the Curve Editor or Dope Sheet open can be very
unresponsive.

• BUG ID 47016 - Dope Sheet: Selecting andmoving keyframes can be extremely slowwhen a large number of
keyframes exist.

• BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is changed.

• BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle systemoccasionally
allows particles to pass through the bounce surface.

• BUG ID 42159 - Nodes that use the Iop::sample() call to get input pixels, such as LensDistortion, perform poorly
when they are downstreamof nodes using PlanarIop, such as Denoise.

Known Issues Specific to Nuke Studio 9.0

Create Comp
• Multi-view, such as stereoscopic, is not supported for track items created using right-click Effects > Create Comp.

• BUG ID 47750 - Retimes are always applied to comp track items, but not the comp script itself, regardless of
whetherApply Retimes is enabled or not.

• BUG ID 47044 - Inserting scripts into comps containing Text nodes using unsupported fonts causes Nuke Studio to
crash when the Text nodes are disabled.

• BUG ID 46470 - Create Comp: Enabling Collate Shot Name in the comp export preset offsets the comp frame
range compared to the annotations precomp frame range.

• BUG ID 41665 - There are currently no options to load or overwrite an existing script when you select Create
Comp.

Keyboard Shortcuts
• BUG ID 47106 -Windows only: Pressing Tab immediately after using theAlt+Shift+1 (Open recent project)
keyboard shortcut causes Nuke Studio to crash.

• BUG ID 34779 - Mac OS X only: The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due
to a conflict with the combination for the umlaut symbol.

To work around this, pressUmomentarily beforeAlt+U.

Preferences
• The Preferences > Path substitution table for cross platform compatibility currently only comes into effect at
project load, not EDL/XML import.

As aworkaround, import your sequence and set the Path substitution rule, then save the project and reload to
force the conversion.

Python API
• BUG ID 44394 - Calling hiero.core.addPathRemap() does not work for soft effect file paths.

RELEASE NOTES FOR NUKE 9.0V5B17 | KNOWN ISSUES ANDWORKAROUNDS
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Read and Write
• Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio on Linux is
scheduled for a later release.

• BUG ID 47312 - Export: Build Track from Export Tag creates track itemswith incorrect timecodes and/or odd
retimes in certain projects.

• BUG ID 46100 - Exporting: Export speedsmay be slower than expected. Thismay be due to theRendering
preference set to limit renderer.
As a work around, you can change the preference Performance > Threads/Processes > Rendering > export
renders to no renderer limits to improve rendering speeds. You can also experiment with the custom renderer
limits, to adjust performance on yourmachine.

• BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash.

• BUG ID 39557 -Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish.

• BUG ID 39113 - Mac OS X only: QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM onMacOS X 10.7.5,
and earlier.

This is a codec issue rather than an application issue.

• BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to other applications,
such as Premiere or Resolve.

• BUG ID 31549 - Single layer exports frommulti-pass clips fail if the selected layer is not a default Nuke layer, such
as depth ormotion.

• BUG ID 28701 -Windows only: Nuke Studio cannot currently parse Unicode characters during export.

• BUG ID 28067 - Certain formats produce nomonitor output, such as 2K 23.98 and 720P 25.

• BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when added to the
timeline.

Soft Effects
• BUG ID 47075 - Exporting sequences containing clip-level Text effects using the [frame] expression writes incorrect
frame numbers.

• BUG ID 42438 - Effects are only visible in the Viewer if there is a track itembelow them in the timeline.

• BUG ID 42401 - Renaming a soft effect does not update the track itemuntil you click in the timeline.

• BUG ID 42307 - Adding soft effects at clip level, usingOpen In > Timeline View, is only available using the add
effect button on the timeline panel. The right-click Effectsmenu is currently disabled.

Viewers
• BUG ID 47159 - Closing and reopening a project in the same session occasionally causes the A input buffer
dropdown to become grayed out or unresponsive.

To reactivate the dropdown, select a track in the timeline and press 1 to place the track in the A buffer.

• BUG ID 42053 - It is currently possible to change the displayed frame range in theCompositing Viewer by
dragging the playhead past the current frame range in Input andGlobalmodes.
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Miscellaneous
• BUG ID 46235 - Compswith relative paths are not currently working when imported into the project.

• BUG ID 43913 - Locking a track currently prevents adding track items from the locked track to the Viewer input
buffers. You can still open track items in the various right-clickOpen In options and access track itemmetadata.

• BUG ID 42462 - Cache pausing stops working if any change ismade to the timeline.

• BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below existing tracks.

As aworkaround, drag the clip to a new top-level track and thenmanually move the track to the required position.

• BUG ID 32613 - Linux only: Dragging clips to the timelinewith certain older NVIDIA drivers occasionally causes
Nuke Studio to crash.

As aworkaround, ensure that you have the latest NVIDIA drivers installed, available from:

www.nvidia.com/Download/index.aspx?lang=en-us

• BUG ID 27484 - It is not currently possible to alter theOutput Resolution of clips opened using the right-click
Open in Timeline option.

Other Known Issues

AudioRead
• BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled between file and
custom.

• BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.

• BUG ID 18465 - The time range control doesn’t limit the rangewhen an endtime is specified.

• BUG ID 18451 - Flipbooking doesn't honor the time range knob.

• BUG ID 18217 - Redo keyframe generation doesn't replace the keys.

• BUG ID 18213 - ChangingDraw Style in the Curve Editor or Dope Sheet doesn't redraw the curves correctly.

BlinkScript/CUDA
• BUG ID 44138 - BlinkScript: float3x3 and float4x4 matrix constructors currently produce a GPU compilation error.

As aworkaround, you can pass the following in as a kernel parameter:
float matrixData[] = {1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1};

float4x4 matrix;

m.setArray(matrixData);

• BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA error when
theOSwakes up from sleepmode.

As aworkaround, close and reopen Nuke to reactivate the CUDA drivers.
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CameraTracker
• BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrezmodes.

• BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image in reference
thumbnails, rather than just the RGB values.

Deep
• BUG ID 43383 - Executing a script in terminalmode that reads in a deep image and then writes it to disk, causes
Nuke to crash.

As aworkaround, run the script from the Script Editor insideNuke.

• BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1.

As aworkaround, preview the .exr in the file browser before reading it into Nuke.

Dope Sheet
• BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in causeNuke to crash when you execute
Analyze Sequence with theDope Sheet open.

• BUG ID 40206 - Adding a curve to theDope Sheet and then deleting it causes Nuke to crash.

• BUG ID 39426 - Undoing individually animated text characters removes their keys completely from theDope
Sheet.

• BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frameswhen frame snap
is enabled.

• BUG ID 38910 - Keys fromViewer buffers not currently being viewed are still visible.

• BUG ID 38630 - Read and TimeClip representations disappear in theDope Sheet if they are set to have a non-
empty frame expression.

• BUG ID 37869 - TheDope Sheet is not updated correctly when a Retime's speed control is animated.

• BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented once in theDope
Sheet.

EditGeo
• BUG ID 38954 - The transformhandle of selections in the Viewer is not updated between frames on geometry with
animation baked into its vertices.

To update the transformhandle, toggle the axis alignment control between object and average normal.

• BUG ID 38699 - Changing the visibility of objects within an Alembic SceneGraph causes geometry to ignore the
EditGeo node.

• BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframemarker.

• BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and corner
vertices.

RELEASE NOTES FOR NUKE 9.0V5B17 | KNOWN ISSUES ANDWORKAROUNDS
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Import Nuke
• BUG ID 40131 - Importing Nuke in a Python script destroys sys.argv, making command line arguments
unavailable.

As aworkaround, preserve sys.argv in another variable before you import Nuke.

• BUG ID 39836 - Importing Nuke hangs when there areQt conflicts between Nuke and other applications.

• BUG ID 38963 - Calling import nuke terminates the Python session if no applicable license is available.

Linux only
• BUG ID 43766 - Calling uuid.uuid4() causes Nuke to crash due to a bug in libc.

As a workaround, launch Nuke from the command line using:
LD_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0

• BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to becomeunresponsive.

Mac OS X only
• BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.

• BUG ID 41981 - Licensing: Launching Nuke on newMacPros withmultiple Thunderbolt devicesmay display a
licensing dialog explaining that FLEXlm licensing has been disabled, probably due to having toomany ethernet
addresses active on themachine.

Please contact support@thefoundry.co.uk to work around this issue.

• BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when you click Save
Report.

• BUG ID 38686 - EnablingUse GPU if available on supported nodes, such as Kronos, in more than one instance of
Nuke at the same time, can cause display corruption and/or entire system freezes. This seems particularly likely to
occur on GPUswith low amounts of RAM, such as theGeForce GT 650M.

As aworkaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU acceleration in one
instance of Nuke at a time.

• BUG ID 35123 - PrmanRender: If you're usingMacOS X 10.8 (Mountain Lion) or above, make sure X11 is installed
on your system. Unlike previous versions of OS X, 10.8 and above do not have X11 installed by default.

Formore information, see http://support.apple.com/kb/HT5293.

• BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch.

As aworkaround, either:

• tarball the installation fromMacOS X and unzip it on the alternate file system (using NFS or Samba, depending
on source), or

• using the command line, copy the installation fromMacOS X to the network location using the same file
system as the destination.

• BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.

As aworkaround, adjust the Viewer gain control to refresh the Viewer.
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• BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script, except when
Nuke is run from the command line.

• BUG ID 13638 - The following graphics cards are not currently supported forMac:

• ATI Radeon X1600

• ATI Radeon X1900

Users with these cards are able to render from the command line, but in GUI sessions, theNodeGraph renders
incorrectly due to a requirement of OpenGL 2 drivers.

• BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.

• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

ModelBuilder
• BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.

• BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry through a
ScanlineRender node causes Nuke to crash.

Monitor Out
• BUG ID 40942 - AJA Io Express: Enablingmonitor output causes Nuke to crash.

• BUG ID 40905 - Decklink 4k Extreme: Enablingmonitor out immediately produces audio interference.

• BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

Particles
• BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to geometry, does not
render all frames to the .nkpc file.

• BUG ID 39796 - ParticleCache nodes upstreamof ScanlineRender nodes display ParticleCache is out-of-date
errors for negative frame numbers.

• BUG ID 39210 - ParticleCache: Errormessages displayed when read from file is toggled on and off are not reliably
cleared when rendering through ScanlineRender.

• BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been calculated within
the particle system.

• BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.

• BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.

• BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind the 3D grid
lines.

Pixel Analyzer and Scopes
• BUG ID 39180 - Scopes: Switching to a layout with a scopewindow, while rendering, forces the Viewer bounding
box to 1x1 for that frame.

• BUG ID 36508 - Scopes do not currently updatewhen zooming into the Viewer.
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• BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include viewer color
transforms is enabled.

PrmanRender
• In theNuke camera, thewindow roll control is not yet mapped to RenderMan.

• BUG ID 27648 - After a security update forMac OS X, Nuke is unable to load the PrmanRender plug-in when in GUI
mode.

See http://support.apple.com/kb/TS4267 formore information.

Python
• BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes Nuke to crash.

• BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when run from the
terminal.

Run the script fromNuke's Script Editor to avoid this issue.

• BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected.

• BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the command line.

To workaround this issue, run the Python script fromNuke's Script Editor.

• BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports incorrect values.

As aworkaround, either call nuke.Node.xpos() ornuke.Node.ypos() first, or ensure no nodes are currently
selected in theNodeGraph.

• BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first created if it
has an autolabel.

• BUG ID 8063 - Creatingmany new nodes with nuke.createNode() and the in-panel argument at default (True)
may crash when toomany node control panels are created too quickly. Theworkaround is to pass the in-panel
argument as False or else usenuke.nodes.NodeClass() (whereNodeClass is the type of node to create) to create
the node and then connect it to the currently selected nodemanually.

• BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from the Script Editor as
that can causeNuke to crash. Instead, you can use the same command from yourmenu.py, restore layouts by
selecting Layout > Restore Layout, or use a custommenu or toolbar item.

• Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:

groupName.NodeName.knobname: unexpected 'k' in '0.knobname'

The problem ismost likely that there is an expression using the input TCL command and doesn't validate that there
is an input connected. An example expression:

[input parent 0].translate.x

The input command returns 0 when it can't find the requested input, which generates an expression of
'0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the value TCL
command and specify a default value to return in the case that the expression is invalid. It takes the form:

[value [input parent inputnumber].knob defaultValue]

Here is themodified example:
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[value [input parent 0].translate.x 0]

Themodified example returns 0 in the event that there is no input 0, and no longer results in an errormessage.

• There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.<node>() if the knob is
called 'in'.

For example, this gives a syntax error:

nuke.nodes.Shuffle(in = 'depth')

while this works because 'in' is a string here and not a keyword:

sh = nuke.nodes.Shuffle()

sh['in'].setValue('depth')

Read and Write
• BUG ID 41357 -Writing out multiple frameswith OFX plug-ins, such as Reduce_Noise, rendersmore slowly in Nuke
8 than previous versions.

• BUG ID 41006 - The last audio frame of aQuickTime encoded with AAC compression ismuted.

• BUG ID 40684 - Rendering certain h264 encoded .mp4 files using themov32 encoder results in color shifts using
QuickTime 10.3 codecs.

• BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to ProRes 4444.

• BUG ID 40074 -Writing out stereo .sxr files with additional channels does not write out both eyes correctly.

• BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect while toggling
the read transform from file in combination with all objects and/or read on each frame.

• BUG ID 35614 - For EXR 2.0 files to be backwards compatible with earlier readers, the layer namesmust not exceed
32 characters in length.

As aworkaround, open the .exr in Nuke 8.0 andmanually (or Pythonically) truncate the names to allow for legal
backwards compatibility.

• BUG ID 35611 -Writing .exrs with theWrite node's interleave control set to channels adds a superfluousmain
view.

• BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to neighboring faces,
leaving gaps in certain circumstances.

This issue is particularly visible when using the EditGeo node, which should not allow you to remove faces from the
geometry.

• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc files.

As aworkaround, ensure that ReadGeo > read on each frame is enabled.

• BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new views to the
project, subsequent reads of any stereo/multiview .exr files won’t give the option to add new views.

• If you have troublewith FBX files, it may be because they werewritten with an older version of FBX. If they load
very slowly, it is also possible that they are ASCII rather than binary. To get around these problems, you can use the
FBX converter on the Autodesk website. It converts between various different formats, including older FBX
versions, ASCII, and binary, and is available onWindows, Mac OS X, and Linux.

To download the FBX converter:
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1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775855.

2. Scroll down to FBX Converter and click on one of the links to start the download.

• BUG ID 41334 - Alembic: Rendering from the command linewith Read from file enabled in the Camera properties
and partial geometry selected in a ReadGeo node, causes Nuke to crash.

Render codecs

There have been issues where rendering with certain codecsmakes Nuke crash. Due to this, we recommend the
following:

• If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec instead. If you're
unable to switch to Sorensen Video 3, try using a format smaller than 2K for better performance.

• If you're experiencing crashes with CineformHD, try updating your Cineform codec to version 5 or above. Youmay
need to download theNeoplayer at http://estore.cineform.com/neoplayer.aspx.

• If you're using Avid Meridien, you should only write out in NTSC and PAL.

Roto/RotoPaint Open Splines
• BUG ID 42997 - Rendering artifacts can occur if the feather control is used in conjunction with the feather handles
in the Viewer.

• BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default.

As a workaround, select the shape and thenmanually change the Properties view control to include both views.

• BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash.

• BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative feather
values.

• BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave erratically.

• BUG ID 42413 - Holding Ctrl/Cmd to move a point's tangent handles independently causes defects in the hull or
feather.

• BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally produces
artifacts in the spline's hull.

• BUG ID 42390 - It is not possible to increase thewidth for individual points if the overallwidth is set to 0.

• BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.

• BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight rendering glitches
inside the hull.

• BUG ID 40433 - Roto Open Splines - Shape of hull/feather curve can look incorrect when width changes greatly
fromone point to the next

• BUG ID 36219 - The Select Feather Points tool does not work consistently between theOpen Spline and
Bezier tools.

Other Roto/RotoPaint Bugs
• BUG ID 41917 - RotoPaint shape colors don't changewhen expression linked to another RotoPaint color.
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• BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo the keyframe
creation.

• BUG ID 32450 - RotoPaint Stereo: Attempting to undomulitple split-control transforms on the same shape reverts
the shape to its original position.

• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn’t extend to the current frame, disappear
when drag-selected.

As aworkaround, select the shape in the curves list to re-display the points.

• BUG ID 30920 - Expression linking extramatrices in the Transform tab doesn’t work as expected.

NOTE: This also applies to SplineWarpmatrices.

• BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent shapes for a
single smooth operation.

• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list.

• BUG ID 28838 - Gizmos fromNuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke 8, but bear in
mind that they won’t be backwards compatible with Nuke 6 once converted, unless you follow the instructions
below:

Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8:

• Click Save As to convert the script to theNuke 8 Roto format, or

• Click Ignore to load theNuke 6 format into Nuke 8. Youmight select this option if:

- You don't intend to make any changes, or

- You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving.

If you want Nuke 8 scripts to load in Nuke 6, use the convertToNuke6 or convertDirectoryToNuke6 Python
functions when running Nuke 8 in terminal only mode:

NOTE: The conversion functions cannot convert stereo-split curves as they are not supported by Nuke 6.

• To convert individual .nk scripts:
convertToNuke6(fromScript, toScript, overwrite = False)

• To convert all .nk scripts in a given directory:
convertDirectoryToNuke6(fromDir, toDir, matchPattern =.*\.nk, overwrite = False)

NOTE: The pattern is a regular expression.

An example single script conversion and rename to the same directory, from the command line (terminal):
$ <NukeInstallDir>/Nuke8.0v1 -t

>>> import nuke.rotopaint

>>> nuke.rotopaint.convertToNuke6(/tmp/myRoto8.nk, /tmp/myRoto6.nk)

• BUG ID 26855 - Theundo and redo buttons in the Properties panel didn’t work as expected and have been
disabled.
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Theworkaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) keyboard shortcuts or the Editmenu
instead.

• BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another frame.

• BUG ID 11524 - Adding strokes/shapes in RotoPaint is slowwhen there is another RotoPaint after it.

• BUG ID 9238 - Painting onMacOS X and Linux is slower when the paint cursor is near the edges of the screen.

• The foreground onion skin overlay updates as you paint, rather than only updating with the new stroke on pen up.

• It is not currently possible to clone RotoPaint nodes.

• Interactivity of laying down strokes/shapes in the Viewermay be faster whenmotion blur is disabled on the layer
you areworking in.

ScanlineRender
• BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input.

• BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in semi
transparent areas.

• BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an image.

Text
• BUG ID 39556 - In text editmode, it is not currently possible to edit text attributes when the Viewer overlay is
disabled.

• BUG ID 39552 - Transforming animation groups using an expression-linked Transformnode does not work as
expected.

As aworkaround, expression link the translate x and y controls separately.

• BUG ID 39483 - Highlighting text in themessage field and Viewer is not always synchronized correctly.

As aworkaround, scrub the playhead to a different frame to update the highlighted text.

• BUG ID 39414 - Text entry in themessage field occasionally requiresmultiple undo operations to remove text.

• BUG ID 39291 - Splitting the transform control on theGroup tab splits all controls.

• BUG ID 39239 - Transforming a character generated from an expression, and then going to a framewhere the
character no longer exists, results in the transformation being lost.

• BUG ID 39130 - Splitting themessage field does not work as expected.

• BUG ID 38789 - Viewer toolbar controls steal cursor focus.

• BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.

• BUG ID 36372 - Selecting a TCL expression in themessage field doesn't always select the result in the Viewer.

Tracker
• BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back the tracked
frames.

As aworkaround, you can enable full frame processing, though thismay increase render times.
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• BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the tracking anchor
coordinates to 0,0.

• BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky.

• BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn't add to the current selection.

• BUG ID 38356 - The zoomwindow occasionally doesn't update correctly when scrubbing between frames.

• BUG ID 32359/32353 - Right-clicking on a point in the Viewer doesn’t always update the available Link to >
Tracker linkingdialog or Tracker options.

As aworkaround, close and re-open the Roto/RotoPaint properties panel to update the Link tomenu.

• BUG ID 29382 - Tracking keyframeswith different sized patterns doesn’t work as expected.

As aworkaround, keyframe patterns should, where possible, be of comparable sizes.

Warpers
• BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display an overlay until
pen-up.

• BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points to 0,0, which
cannot be undone.

• BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are removed.

• BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot currently be
undone.

• BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve ismoved to a new layer.

• BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.

• BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to display the
cropped image and the black area between the crop box and the format whenmerged over a background.

• BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid lines.

• BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect inmorphmode, whenmix is set at an
intermediate value.

• BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes rendering
problems.

• BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when inmorphmodewithmix set
at an intermediate value.

• BUG ID 19386 - GridWarp: All keyframes are removed from theDope Sheet after undoing, rather than just the
latest, and the keyframes remain on the timeline and in the properties.

• BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.

• BUG ID 19079 - SplineWarp: TheC keyboard shortcut does not currently select theAdd Correspondence Point
tool.

• BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes, even if a grid is
not visible in the Viewer.
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• BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different positions, does not
undo as expected.

• BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or Dope Sheet.

• BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new grid using the
Draw Boundary Viewer button.

• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A shortcut.

• BUG ID 18012 - GridWarp: The grid can flicker between white and grey when zooming in and out of the Viewer,
particularly when the grid is subdivided.

• BUG ID 17697 - GridWarp: In stereomode, the right view is labelled as default when you split controls into
separate views.

Windows only
• BUG ID 44186 - Pasting a file path into Nuke's Script to open file browser and pressing Return occasionally
causes Nuke to becomeunresponsive or crash.

• BUG ID 40762 - Python: TheQtWebKit DLL does not load correctly.

• BUG ID 40407 -When using a tablet, Nuke does not automatically switch to Erasermodewhen you use the erase
end of the pen.

• BUG ID 39636 - QuickTime: TheBlackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422 (2vuy) pixel
format due to a bug in the codec, resulting in solid green frames.

As aworkaround, manually set the pixel format to b64a RGB to preserve image fidelity.

• BUG ID 35800 - Scopes: The alpha channel doesn't update correctly whenmodified through a node, such as
Primatte or Shuffle, even after the node is removed from theNodeGraph.

• BUG ID 28921 - Changing the 3D selectionmode does not update until you click in the Viewer.

Miscellaneous Known Issues
• BUG ID 42339 - TheModo Viewer control scheme (Preferences > Panels > Viewer Handles > 3D control type)
does not work as expected.

• BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel doesn't work as
expected.

• BUG ID 41450 - AppendClip forces upstreamnodes to re-evaluate on every frame.

• BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the same name as
the file path to the original.

WARNING: If you save this empty script when the network drive is reconnected, the original is
overwritten.

• BUG ID 41122 - MatchGrade:Match Different Clipmode does not allow you to set keyframes on the Target for
.mov clips with a frame range offset.

• BUG ID 40617 - Some filter nodes, such as Erode (fast), are cachingmore slowly than in previous versions.
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• BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down themiddle-mouse button,
pastes values into the control.

• BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, theNuke<>Mari bridge
won't work unless all instances of Project3D are renamed appropriately in themari_bridge.py file.

• BUG ID 39365 - The Viewerheadlamp control can not currently bemanaged using expression links.

• BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the nodes from the
NodeGraph.

• BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.

• BUG ID 39122 - Switching the Viewer towipemode and wiping between inputs with different format sizes causes
corruption and constant refreshing in the Viewer.

• BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.

• BUG ID 37279 - Viewermasks obscure overlays, such as Crop handles and Roto curves, as well as the image itself.

• BUG ID 35976 - SomeCUDA code runs in rendermode, even when the --gpu argument is omitted.

You can disable all CUDA code by setting the FN_NUKE_DISABLE_CUDA environment variable to 1.

• BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the script, resulting in
error when the path doesn't exist:
Flipbook render failed: viewerCaptureOp: Cannot write to specified path

• BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the captured images.

• BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or whenmousing over the
Viewer.

• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.

• BUG ID 32628 - DeepToPoints: Command line rendering appears to calculate renders even when render is set to
off.

• BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely consistent with REDCINE-X and Hiero.

• BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output layer produces
corrupt output.

As aworkaround, shuffle the depth information to an alternate layer.

• BUG ID 32118 - Card3D: Whenmotionblur is enabled in the properties, FrameHold and TimeOffset nodes are
ignored when connected to the cam or axis inputs.

• BUG ID 31803 - Using Shift+drag on a control’s animation icon only copies the value for the current frame, not the
entire expression.

• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual bounding
boxes for polymesh primitives.

• BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect cameras, lights, or axes.

• BUG ID 31238 - RAM cache: Any action that changes a frame’s hash value, it’s unique identifier, causes the cache to
release. Actions such as adjusting the ViewerGamma,Gain, or channels dropdown affect the frame hash.

• BUG ID 30502 - Copying and pasting spline keys does not work as expected in theDope Sheet.

NOTE: This known issue only applies to Roto and SplineWarp keys.
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• BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the node is
copy/pasted in theNodeGraph.

• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.

• BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a Scene node only
displays the animated Camera in the Viewer. There should be two cameras: one static and one animated.

• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal length of the
new camera does not match that of the Viewer camera.

• BUG ID 28291 - Nuke crashes on startup if thedisk cache location set in the Preferences is no longer available.

• BUG ID 20431 - CameraTracker: It’s not possible to pick colors in the Viewer with the control panel open.

• BUG ID 20204 - Multitexturing: When Preferences > Viewers >Multiframe is enabled, increasing downrez in
the Viewer toolbar can cause textures to flicker in the 3D Viewer.

You can switch back to Classicmode or avoid using proxy in 3D to workaround this issue.

• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the Viewer.

• BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch in the
Properties panel.

• BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.

• BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because some large
polygons are clipped by the front camera plane.

You canminimize this effect by increasing the geometry tessellation max parameter.

• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or zooming.

• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and points drawn
with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and the other in 3D mode, and you
have the panel for the RotoPaint visible.

• BUG ID 9521 - Currently, theNuke Viewer cannot cache very large plate sequences in float. The limit per frame is
50MB. If your frames are larger than this, youmay need to switch to proxy mode for the caching to work.

• BUG ID 5922 - At themoment, cloning does not work properly with all OFX nodes. This affects, but is not restricted
to, any nodes that have an analysis pass.

• BUG ID 5690 -Windows run-time libraries are not packaged properly with Nuke.

Nuke runs correctly from a network install onWindowswithout specifically installing the run-time libraries, though
we still recommend that you do so as there are still someminor problemswithout them.

• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render. This question is
unnecessary as the result is an anaglyph image. Irrespective of what view you choose, the flipbook output is the
same.

• File types inWindows andMacOS X are associated with the standard version of Nuke by default, so if you save a
script on NukeX using features that are only included in NukeX (such as CameraTracker or FurnaceCore) and then
double-click on the script icon to open it, it opens in standard Nuke instead of NukeX.

• CameraTracker: Canceling lens distortion initialization results in corrupt tracks.

• 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker nodewhen using
Create Scene:

RELEASE NOTES FOR NUKE 9.0V5B17 | KNOWN ISSUES ANDWORKAROUNDS



25

• Select the Camera that was created in the 3D viewwhen using theCreate Scene button.

• Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to focus (using F)
on the point cloud. The resulting tumble cameramovement is likely to be jumpy.

• Plug-ins installed using theNuke Plug-in Installermay not work correctly as they were compiled against an earlier
version of Nuke.
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Developer Notes
Here are the changes relevant to developers. SeeHelp > Documentation from theNukemenu bar formore
information.

NOTE: NodeClass() names occasionally change betweenmajor releases, such as Nuke 7 to Nuke 8. While
these changes do not affect legacy scripts, youmay not get the results you were expecting if a node class
has beenmodified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node
class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 7 and Nuke 8, the Text nodeClass() changed from Text to Text2. In the
toolbars.py file for the two releases, the entries for the Text node appear as follows:

m.addCommand("Text", "nuke.createNode(\"Text\")", icon="Text.png")
m.addCommand("Text", "nuke.createNode(\"Text2\")", icon="Text.png")

New Features

There are no new features in this release.

Feature Enhancements
• BUG ID 47140 - Python bindings have been added for creating customPreferences pages.

• BUG ID 47352 - Soft Effects: You can now specify the following texture uniforms in custom shaders:

• float input0_tex_width and float input0_tex_height (including input1 versions for dissolves)

• vec2 input0_fullFormatSize and vec2 input0_currentFormatSize

• vec2 outputFullFormatSize and vec2 outputCurrentFormatSize

• vec4 input0_bbox (including input1 versions for dissolves)

Bug Fixes
• BUG ID 47069 - Using Python to import a clip into Nuke Studio and then export it to a Nuke script did not work as
expected, based on thenuke_write.py script shipped with Nuke.

• BUG ID 47179 -Windows only: Calling PanelNode() occasionally caused Nuke to crash on shutdown.

• BUG ID 47603 - Themenu.addCommand() argument shortcutContext didn't work when used in conjunction
with the index argument.
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